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THE ALL-NEW HD2x FROM AIRWOLF 3D

Printing in one material or one color is a thing of the past. Welcome to dual color/dual material printing
with the all-new HD2x from Airwolf 3D. The HD2x features a print volume of (11"x8"x12"), and offers
layer-to-layer resolution as fine as .06mm (.002"), lightning-fast speeds and a partially enclosed, yet
easily accessible proprietary frame design. The HD2x is also fully autonomous, meaning that it is not
necessary to couple it to a computer to print. The HD2x comes standard with Airwolf's new proprietary
JR2x dual high temperature hot end, and hosts a number of new features including upgraded motors,
durable nylon extruder gears, a finer 2mm threaded Z rod, and enhanced movement control speeds.

» Dual extruder for 2 material / 2 color printing

» Large 11 x 8 x 12" build envelope

» Fastest Print Speeds in its class

» Prints in over 20 different materials

» Reliable, high-torque motors

» 2mm pitch z-rod provides excellent z resolution
» Fully autonomous control

» Patented one-piece / 2 nozzle hot end design

» Finest layer resolution in its class

= Durable, nylon extruder gears

» Interchangeable nozzles for fine resolution printing

1 DO NOT LEAVE UNATTENDED 1l




TECHNICAL SPECIFICATIONS
MODEL: HD2x

ASSEMBLED: YES

NUMBER OF PRINTING MATERIALS: 20+
BUILD ENVELOPE WxDxH: 11" x 8" x 12"

BUILD VOLUME: approx 1,150 cubic inches
(18,878 cubic centimeters)

NOZZLE DIAMETER (mm): .5 + .35 (optional)

FILAMENT DIAMETER: Nominal: 3.00mm
Actual: 2.85 +- 0.1mm

MINIMUM LAYER THICKNESS (mm): .06

MAX SPEED (mm/s): Perimeter 150 mm/s,
Travel 400 mm/s

1 DO NOT LEAVE UNATTENDED 1l

THEORETICAL POSITIONING PRECISION
(mm): .02

INPUT FORMAT: Gcode

SOFTWARE: Marlin Firmware, Repetier Host
Print Controller, Cura

SYSTEM COMPATIBILITY: WINDOWS/MAC

PRINTER SIZE WxDxH: 24" x 18" x 18" (600
mm X 440 mm X 450 mm)

POWER SUPPLY: Internal auto-switching
13.5V DC, 320W

WEIGHT: 18kg




BOX CONTENTS

PET
'

AIRWOLF 3D QUICK START GUIDE SPOOL OF ABS FILAMENT GLASS WITH PET FILM
HD2x PRINTER

@

USB DRIVE WITH PRINT MICRO SD CARD WITH HEX WRENCH SET
SETTINGS SAMPLE PRINTS
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HOW IT WORKS

1 spooL OF FILAMENT

The extruder gears and hobbed bolt pull the filament from the spool and feed it into the
guide tube.

2 CXTRUDER GEARS AND HOBBED BOLT

The extruder gears and hobbed bolt pull the filament from the spool and feed it into the
guide tube.

3 HOTEND

For a dual color/material print, you will notice one head purging out material. At this stage, it
is priming itself to begin the print. During printing, you will notice one nozzle retracting while
the other is extruding in order to execute a clean color/material change.

LNoz7LE

Once the pressure is built up, the printer will start printing your part, layer by layer.

HOT END AND HEAT BED MOTION/AXIS

TOP VIEW

E FRONT VIEW

HEAT BED

TOP VIEW
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VIKI LCD SCREEN

Out of all the features the VIKI LCD Screen has, there are four main ones that you will use regularly.
They include Auto Home, Preheat ABS, Move Axis and Print from SD. The following page has a layout of
all of the features the VIKI has to offer and these four functions are underlined.

Auto Home- Auto Home (AKA the origin) will use the minimum limit switches to move the nozzle to the
front left corner, and the bed to the top. Home is very important because that is where every print will
start from automatically.

Preheat ABS- Preheat ABS is a great feature for preheating your printer before printing. When you are
done designing, slicing, and loading your SD card, your printer is ready to go.

Move Axis- Move Axis allows you to manually move the nozzle and bed in each direction. This is
also where you will extrude material through the nozzles. Purging is very important when switching
materials.

Print from SD- Print from SD is where you can access the GCODE files on your micro SD card. We have
already loaded a library of sample prints for you to run right away.

HOME SCREEN

This is the home screen for the VIKI LCD Screen. There are two heated components on the printer, the
nozzle and the bed. Both actual and target temperatures are displayed. The “FEED RATE" is a multiplier.
At 100%, the printer is running exactly what the GCODE is instructing it to do. If the feed rate is increased
or decreased, the printer will speed up or slow down in every direction. To change the federate, turn

the dial on the VIKI home screen and watch the percent change. It is not recommended to go any faster
when using the fast settings. The SD Card _ _% is how full your micro SD Card is. The “Time" is the
amount of time that the printer has been printing its current job.

Nozzle 1 Temperature (°C) Nozzle 2 Temperature (°C) Bed Temperature (°C) Z-Axis Location
Actual / Target Actual / Tar&et Actual / Target -~
~ ~ N \ 2 7 -’ -
N ~ PR < -

02425080, 1242 02405
BEiinsl2e” ZEAN. A6

R100%  Bl=~—% B—v-i--
Hirowl# HDEg readg.

/ 1 N S
Feed Rate __% SDCard __% Time __: Printer Status
(Speed Multiplier)




VIKI'LCD LAYOUT

USING THE VIKI LCD SCREEN:

First, insert the micro SD card into the slot on the front of the
printer. Use the center button to move between rows. Use the
scroll function to move left and right. “Print from SD" will display
the GCODE files on the card. Remember, these files are specific to a
certain type of material.

MICRO SD CARD: WHEN INSERTING A NEW MICRO SD
CARD, IT MAY BE NECESSARY TO CLICK “INITIATE SD
CARD,” SO THE CARD CAN BE RECOGNIZED.

PREPARE OR PRINT FROM
TUNE SD

|

MICRO
SD- SAMPLE
PRINTS

NOZZLE= 210C NOZZLE= 240C
BED= 60C BED= 120C FAN SPEED

DISABLES STEPPER

MOTORS SO THE HOT | MOVES NOZZLE TO TURNS OFF THE

END CAN BE MOVED T RONT SEFT CORNER, NOZZLE AND BED

MANUALLY HEATERS



VIKI LCD: HOW TO

The four main functions of the VIKI LCD screen are to prepare the printer for printing, manual control,
running a print and controlling the printer while running a print. Use the layout on the previous page as a
road map to find each function. To navigate between rows, simply click the center button. Use the scroll
wheel to navigate left and right in the road map. If left idle for 15 seconds, the VIKI will return to the
home screen.

PREPARE: The main functions used under “Prepare” are “Auto Home," “Preheat ABS,” and “Move Axis.’
“Auto Home" will instruct the printer to move the extruder to home in each direction (X, Y, Z). The printer’s
HOME position is essentially the origin in the XYZ coordinate system. “Preheat ABS"” will turn on both
heaters for the extruder and bed and heat them to ABS temperature ranges. This way, when you start
your print, the printers temperatures will be in the correct temperature range for the material you are
printing.

MANUAL CONTROL: Under “Prepare,” you will find the “Move Axis"” function. Once selecting increment
and axis, the extruder and bed can be manually controlled by the user. This function can be used to purge
the machine of a previous material or color. When changing materials, purge between 500 and 1000mm
to completely get rid of any old material in the head. (See the material section for more info on specific
materials.

PRINT FROM SD: “ Print from SD" utilizes GCODE files to run the printer. Once an STL file is sliced and
GCODE is created, it can be saved onto the micro-SD card. Keep in mind that once a part is sliced, that
GCODE file is for a specific material (temperatures, speeds, etc.

TUNE: There are a few settings that can be altered during a print by using the VIKI LCD screen. One of
them is speed or feed rate. This will speed up or slow down a print. The rule of thumb is not to go any
faster than the Airwolf 3D standard fast settings, and to not go any slower than the Airwolf 3D slow
settings. At 100% the printer is running the GCODE exactly, utilizing the print settings. Above 100%, the
printer will increase its speed; below 100%, the printer will decrease its speed. It is not recommended to
increase the feed rate higher than 125% or lower than 75%. This is mainly because of the retraction in the
bowden system.

The other way to increase or decrease speed during a print is to spin the wheel while looking at the home
screen; this will cause the feed rate value to change accordingly. The nozzle and bed temperatures can
also be altered during a print. For big or tall parts, it may be useful to increase the bed temperature during
the print. The fan speed is only used for materials that would require fans (refer to “Materials Section”).
ABS does not requite fans.




RAMBo DRIVER INSTALLATION

WINDOWS 8

Windows 8 by default will not let you install unsigned drivers. This means that a Windows
8 computer will not recognize the RAMBo board unless you follow these steps to start
Windows 8 in “Disable Driver Signature Enforcement” mode.

1 SETTINGS BUTTON

Move the cursor to the bottom right corner of the screen and select the GEAR icon
“Settings.’

2 CHANGE PC SETTINGS
Select “Change PC Settings”

Notifications

Change PC settings

PC setti...
Personalize
Users
3 a G E N E RAL Notifications
If you see “General” come up, select it and proceed to step 4 Search
Share
Privacy
Devices
3 b UPDATE AND RECOVERY Ease of Access

Sync your settings

If you do not see the “General” option, select "Update and Recovery.’

Search & apps

(© Update & recovery »

Privacy

Metwork Windows Update

Time & language o
= UG File History

Ease of Access Rty

Update Bt recovery




I

RAMBo DRIVER INSTALLATION

l|- ADVANCED STARTUP > RESTART NOW
Scroll down and select “Restart Now" under “Advanced Startup!

T R
Amibirt s
1 vefiesh it without loing your files

Choose an option

5 TROUBLESHOOT > ADVANCED OPTIONS > STARTUP SETTINGS

Continue

acvanced tools

After selecting “Startup Settings,” select "Restart.”
Troubleshoot .

Advanced options
Startup Settings

e
i por n Changs Windows startup beharior

tem Res

.‘.‘ L.

Startup Repair

Startup Settings

Press a number to choose from the options below:

6 RESTART > CHOOSE OPTION 7
The PC will restart. Upon startup, click the “7"
key on your keyboard.
Use number keys or functions keys F1-F9.
1) Enable debugging
2) Enable boot logging
3) Enable low-resolution video

4) Enable Safe Mode
5) Enable Safe Mode with Networking

6) Enable Safe Made with Command Prompt
7) Disable driver signature enforcement

8) Disable early launch anti-malware protection

7 INSTALL RAMBo DRIVER
ODINSTALL THE RAMBo driver
9) Disable automatic restart after failure



RAMBo DRIVER INSTALLATION pc onwyy

1 Only PC computers need the RAMBOo driver.
2 Plug the printer into the computer with the USB cable. Insert the Airwolf 3D USB drive
(came with the printer) into the computer.

3 In the “Control Panel,” open “Devices and Printers.” Under “Unspecified,” you should see

a device labeled "RAMBo." Right click the device and select “Properties.”

= e
C/ll‘\:} |L§‘§ » Control Panel » Hardware and Sound » Devices and Printers » - | ¥4 || Search Devices ond Prinfers o
Add a device Add a printer = v ._9.

4 Unspecified (1) i

@

Al ! E
RAMEo =
_ '/ 13 items

“'qlgf

l" A second window will appear. Under the second tab labeled “"Hardware,” select
"Properties.”

5 A third window will appear. Under the first tab labeled “General,’ select “Update Driver!
.} RAMBo Properties =5) RAMBo Properties (]
| General i General | Drver | Detais

i, - % oy
£

Device Functions:

i Tane Device type: Cther devices
[ RAMBo Cther devices Manufacturer: LUnknown
Location: Port_#D002 Hub_#0004
Device status

[The drivers forthis device are not installed. (Cods 28)

There is no driver selected for the device information set or
element.

Device Function Summarny

Manufacturer:  Unlenown To find a driver for this device, click Update Driver.
Port_#0002.Hub_#0004

Device status: The drivers for this device are not installed. {Code 28}

Location:

| Properties |




RAMBo DRIVER INSTALLATION pc onwyy

6 : - —— S
A fourth window will |\ ) Il Update Driver Software~RAMBa,

appear. Select "“Browse my

How do you want to search for driver software?

computer for driver software.”

= Search automatically for updated driver software
Windows will search your computer and the Internet for the latest driver software
for your device, unless you've disabled this feature in your device installation
settings.

= Browse my computer for driver software
Locate and install driver software manually.

— [E=)
|@ Il Update DrwerSofnvarg._;._EAME_h

7 Select the "Browse” button.

Browse for driver software on your computer

Search for driver software in this location:

[7] Include subfolders

< Let me pick from a list of device drivers on my computer
This list will show installed driver software compatible with the device, and all driver
software in the same category as the device,

Nedt | | Caneel

8 Browse for the Airwolf USB stick. Select the folder # e Removable Disk (F)

> | Firmware-related
. . MatterControl (very easy)
"RambO DI’IVEI’" and SE'ECt “OK." . Rambo Driver
. Repetier Host (more advanced)
. SAMPLE PRINTS!!
> Slic3r9.10b (advanced)

9 The window will close and return to the “search for | SLICER 9.10b CONFIGURATIONS

J STL GCODE SLIC3R CONFIG
. " . €3
driver” screen. ¥ Network
. Desktop
D [l Update Driver Software - RAMBk
Browse for driver software on your computer Folder: Rambo Driver

Search for driver software in this location:

F:\Rambo Driver| - Browse...

[¥]Include subfolders

i  Let me pick from a list of device drivers on my computer

This list will show installed driver software compatible with the device, and all driver
software in the same category as the device.




RAMBo DRIVER INSTALLATION pc onwyy

1 0 Another screen may appear and say “Windows can't verify the publisher of this

driver software.” Select “Install this driver software anyway.’

s =T
k' Windows Security lﬂ

Windows can't verify the publisher of this driver software

+ Don't install this driver software
: You should check your manufacturer's website for updated driver software
for your device.

2 Install this driver software anyway
Only install driver software obtained from your manufacturer's website or
disc. Unsigned software from other sources may harm your comnputer or steal
information.

1 1 If installed correctly, this is the screen you should see. Select “Close -> Close,” and
IIOK.II i@ —_— ﬁ‘

| U Update Diriver, Sthwarg_, RAMEE: 3[} Printer Electronics Board (COMLT)

Windows has successfully updated your driver software

Windows has finished installing the driver software for this device:

RAMEBo 30 Printer Electronics Board

1 2 Now in your “Devices and Printers,” under “Unspecified,’ this screen should show.

If installed correctly, you will see a COM number. The “(COM17" is dependent on what USB

port on the computer the printer is plugged into. Yours may display a different COM number.

&5 » Control Panel » Hardware and Sound » Devices and Printers » v [# Search Bevices.and Fiin
; = — — — e
\
1

Add a device Add a printer

|4 Unspecified (1)

RAMBo3D |
Printer
Electronics Board
(COM1T)

Category: Unknown

= r-}_ RAMBo 3D Printer Electronics Board (CO...  Modek RAMBo




SOFTWARE INSTALLATION: CURA

Introduction to Cura:
Cura will be your slicing engine for printing. First it will be set up for single head printing and
then set up for dual head printing.

1 Download Cura. Visit http:/www.software.ultimaker.com 2 [ software.ultimaker.com

2 Launch Cura Installer

: ] = il

Choose Components
Choose which features of Cura 14.07 you want to install.

3 Choose which file types you would
like Cura to open by default. Make sure
you have “STL" and "AMF" checked.
Uncheck “Install Arduino drivers.”

Click Install.

Chedk the components you want to install and unched: the components you don't want to
install. Click Install to start the installation.

Select components to install: Cura 14.07

(W] irstall Ardina Drivers|
Open STL files with Cura

[] Open ©OB1 files with Cura
COpen AMF files with Cura
[] Uninstall other Cura versions

Space required: 85.0MB

’ < Back ‘[ Install ]I Cancel

ll‘ When the software extract|on is complete, click “Next." Then click “Finish.”
_ € coneorsecc S| -

Completing the Cura 14.07 Setup
Wizard

c Cura 14.07 Seiup

Installation Complete
Setup was completed successfully.

Completed
R ——

Cura 14,07 has been installed on your computer,
Click Firish to dose this wizard,

[¥]start Cura 14.07

e Eirst ti

First time run wizard

Welcome, and thanks for trying Cura!

This wizard will help you in setting up Cura for your machine,


http://software.ultimaker.com/
http://software.ultimaker.com/

SOFTWARE INSTALLATION: CURA

6 Select Your machine: Select “Other (Ex: RepRap, MakerBot)" then click “Next.”

Select your machine

What kind of machine do you have:
() Ulimaker2

(71 Ultimaker Original

(1 Printrbot

@ Other (Ex: RepRap, MakerBot)

7 Other machine information:

Select “Custom...,” then click “Next.” Other machine information

The following pre-defined machine profiles are available

Mote that these profiles are not guaranteed to give good results,
or work at all, Extra tweaks might be required.

If you find issues with the predefined profiles,

or want an extra profile.

Please repart it at the github issue tracker,

(71 BFB
I DeltaBot
(| MakerBotReplicator
~1 Mendel
() Prusa Mendel i3
1 punchtec Connect XL

1@ Custom...

8
Machine Specifications: Fill in '

_ _ Custom RepRap information
data according to the picture then

RepRap machines can be vastly different, so here you can set your own settings.

H 1T =H " Be sure to review the default profile before running it on your machine.
click “Finish. i i

If you like a default profile for your machine added,
then make an issue on github.

You will have to manually install Marlin or Sprinter firmware,

Machine name Airwalf 30 HD2x
Machine width (mm) 280
Machine depth {mm) 200
Machine height (mm}) 300

Mozzle size {mm}) 0.5

Heated bied [#]
Bed center is 0,0,0 (RoStock) [ ]

Dual Head Machine Specifications: Only follow these steps if setting up the HB

olor / dual material printing. See next page.




SOFTWARE INSTALLATION: cura (DuAL)

lCua- 140
File Tools Expert Help

1 0 Open Cura: Click on the o

“Machine” tab in the top menuand | Quaiity

Layer height {mm) 0.1

click “Machine Settings.” e e —
Enable retraction [
Fill

Bottom,Top thickness (mm) 0.6
Fill Density (%) 20
Speed and Temperature
Print speed (mm/s) 50

Printing temperature (C) 220

1 1 Click the button “Add New  [Machine settings

T
o Airwolf 3D Hd2X. | -
Machine. Machine settings Printer head size
E-Steps per 1mm filament 0 Head size towards X min (mm) 0

Maximum width (mm) 230 Head size towards ¥ min {mm) 0
Maximum depth {mm) 200 Head size towards X max (mm) 0

Maximum height (mm) 300 Head size towards ¥ max (mm) 0

- | Printer gantry height {mm) i}

Extruder count

[2
Heated bed [ o )
Maichine center 0,0 | Communication settings

Build area shape [Square YI Serial port
GCode Flavar lRepRap {Marlin/Sprinter) - | Baudrate

| Ok | iAdd new machine | I Remove machine ‘ | Change machine name |
e—

1 2 Add New Machine Wizard: Click "Next.

Add new machine wizard

This wizard will help you in setting up Cura for your machine.

1 3 Repeat steps 6-8. Use the exact same settings for the bed dimensions. Give the
printer a new name (i.e. HD2x Dual).

The "Machine Settlngs [ Airwolf 30 Hd2x | Airwodezxﬁ'l—‘

Machine settings Printer head size

window will re-open. For the “Extruder
ount, “make sure to select “2." This will
Dual” to be a dual head

n

E-Steps per imm filament 0 Head size towards X min {mm} 0

Maximum width (mm) 230 Head size towards Y min {mm) 0

200

Maximum depth {mm) Head size towards X max (mm) 0

Maximum height (mm) 300 Hezd size towards ¥ max {mm) 0

Extruder count [2 b | Printer gantry height {mm) 0

ay o .
Machine center 0,0 1] Communication settings
Build area shape [Square V] Serial port AUTC - e
GCode Flavar IRepRap {Marlin/Sprinter} - | Baudrate AUTO -

Ok | | Add new machine | I Remave machine I | Change machine name |




SOFTWARE INSTALLATION CURA (DUAL)

i TCura

1 5 Go back to the ”MaCh|ne" dI’Op File Tools .Expext Help |

Basic | Advanced | Plugins | Start/End-GCode LeeE)

down and select “Machine settings.’ Sy =

Layer height {mm) 0.1

Shell thickness (mm) 0.8 i &

Enable retraction &

Al

Bottom,Top thickness {mm) 0.6

Fill Density {36) 20

Speed and Temperature

Print speed (mm/s) 50

Printing temperature (C) 220

1 7 Make sure that under Extruder 2, the "Offset Y” and “Offset X" are both set to O.

Extruder 2
Offset ¥ 0.0
Offsety 0
[ Ok ] [ Add new machine ] [ Remove machine ] [ Change machine name ]

1 8 Curais now ready to prepare dual color / dual material files. You can delete the robot

that comes with Cura as default by right clicking the figure and selecting “"Delete Object.”

Cura - 14.07
ile Tools Mth Expert  Help
c | Advanced [ Plugins | Start/End GCode |

Quality

Layer height (mm}) 0.1
Shell thickness {mm}) 10
Enable retraction

Hll
BottomTop thickness {mm) 0.5
Fill Density (%)

Speed and ul
Print speed (mm/s) 50

=}

||

Printing temperature () 220
Ind nozzle temperature (C) 0
Bed temperature (C)

Support
Support type
Platform adhesion type

Support dual extrusion

Dual extrusion

\WipeSprime tower
Ooze shield

Filament
| Diameter {mm) 2.85

E“j iii |
Ll 4 |

Diameter2 (mm)

=

Flow (%)




SOFTWARE INSTALLATION: repeTiER HoST

1 Download Repetier Host. Repetier-Host Windows 1.00
Visit http:/www.repetier.com/download/ RC2

e
{EE-J Setup - Repetier-Host

2 Run the Install File. Once |

the installation is complete,

Installing
Pleaze wait while Setup installs Repetier-Host on your computer,

click “Finish!” Extracting files...
C: V.. \Repetier Host'Slic3r ibwrtif046bb 76 18947 772494341 fich 1 2d 120Dyl

3 Open Repetier Host. Click
“Printer Settings” in the upper right

menu. A new window will now open ﬁg O L |
p o g
o

Printer Settings | Easy Mode Emergency Stop
cer | Preview | Manual Control | 5D Card

with the “Connection” tab active.

l|. Name the printer. Replace

Connection |F‘n'n1&_r i Edruder | Printer Shape A::I\rancedl

“Default” with a new printer name

| Connector: [Sen‘al Connection ']
(i.e. HD2x). While still in the -
Port: COM11 - | Refresh Parts
“Connections” tab, also change the Baud Rate: 250000 A
Transfer Protocol: bt ,J
Baud Rate to 250,000. R -
Reset on Emergency ISend emergency command and reconnect VI
Connection |ﬂ;‘ﬁ?| Extruder I Frinter Shape: I Mvancedl
5 Click on the “Printer” tab, then Travel Feed Rate: 4300 fmm/min]

Z-Auis Feed Rate: 100 [mm./min}

change the “Default Extruder

Manual Extrusion Speed: 1

0 240C, and the

Manual Retraction Speed: 5

- 0" to 1 15C Default Extruder Temperature:
Ual Extrusion Speed: 1 & 5 MM/S | il

Pl and other soft materials

and other hard materials


http://www.repetier.com/download/

SOFTWARE INSTALLATION: repeTiER HoST

6 Designate the number of | _ HD2e = |
EXtI’UderS C“Ck on the IlConnection I F‘rirlterl Extruder iF‘rirrterShape I Advanced |
“Extruder” tab, then select “2" Hlmberof Birucer A =
Max. Bxtruder Temperature: 320
under “Number of extruder.” o B Teicas 2

Max. Volume per second .'I.Z [mm3/s]

Change the diameter of

“Extruder 1" and “Extruder 2"

[7] Prirter has a Midng Extruder {one nozzle for all colors)

Extruder 1
to .5 mm. Select different colors | "=

Diameter: : [mm} Temperature Offset:
for the two nozzles i

Offset X:

Bxtruder 2

Name:

Ciameter: [ .. [mm] Temperature Offzet:
Color:

Offset X

7 Click on the “Printer Shape”

tab.Set the "X Maxto 280, and %yprsrse N
Finter .E I"lgﬂ%
the "Y Max" to 200. This sets Printer HD2¢ i |

| Connection | Prirter | Extruder | Prirter Shape | Advanced |

=~

the maximum travel the head is

»

Printer Type: [Classic Printer "] —
able tO reaCh il’l these direCtiOI’lS. Home X: Min » | HomeY: |Mir1 w | Home Z: Min -
For the print area, set the Width || xm. o XMax 280 Bedleh: 0
Y Mi 1] Y M 200 Bed Front: 0
to 280, the Depth to 200, and ) = -
Print Area Width: 280 mm
the Height to 300. Click “Apply” [Jf Pt Area Deph: 200 i |
" " . Prirt Area Height: 300 mm
and O K to Sdve the Settl ngs The min and mzx values define the possible range of extruder coordinates. These coordinates
can be negative and outside the print bed. Bed left front define the coordinates where the
printbed itself starts. By changing the min/max values you can even move the ongin in the
center of the print bed, if supported by fimware.

i




5S5TEPS TO 3D PRINTING

Now that we have installed the software, this section will cover the main steps to printing.

1

DESIGN OR DOWNLOAD 3D MODEL: When doing this, Keep in mind the printing
orientation and the printing material(s) that you are going to use.

PROGRAMS: Sketchup, Solidworks, Rhinoceros, etc.

WEBSITES FOR 3D MODEL DOWNLOAD: Thingiverse, GrabCad

FILE FORMAT: .SKP, .SLDPRT, .3DM, etc.

CONVERT TO STL FILE TYPE: “Export” or “Save As" the 3D model into an STL file type.
Make sure to include the “stl” file extension if it does not already have it. Some
software packages may require a plug-in to export as STL (i.e. Sketchup). The Dual
Head section of Cura will discuss how to export multiple STL files.

PROGRAMS: Sketchup, Solidworks, Rhinoceros, etc.

FILE FORMAT: .STL

CLEAN UP STL FILE (THIS STEP IS OPTIONAL): Cleaning up the STL file may be
necessary after creating it. This will help the slicing engine create the GCODE.

If you skip this step and your file will not slice correctly, bring it into Netfabb for repair.
PROGRAMS: Netfabb, MeshLab

FILE FORMAT: .STL

SLICING THE 3D MODEL: Other than the design process, this is the most critical step
in 3D printing. This is where you will apply print settings to your 3D model (i.e.
temperature, infill, layer height). It is very important to have the right settings. Each
setting is VERY dependent on the material.

PROGRAMS: Cura

FILE FORMAT: .STL and .INI

PRINT: Once the GCODE has been created by the slicing engine, the model can be
inted using Repetier Host or from the micro SD card.



http://www.thingiverse.com/
http://grabcad.com/
http://www.netfabb.com/

SLICING PROCESS

3D MODEL

SLICING STL

CAD: This is where the 3D
model will be designed and then
exported into an STL file.

STL: The STL file is then
exported into the slicing engine
(Cura). This is where the settings
are applied for the different
materials. Generating support
will be done here as well.

GCODE: The GCODE is then
exported. It can be copied to
the SD card and printed from
the LCD screen OR it can be
loaded into Repetier-Host. In
RH, it can be viewed, analyzed
and printed.




GUIDE TO 3D PRINTING

1 DESIGN OR DOWNLOAD 3D MODEL: There are a couple of websites where 3D models can be
downloaded from. Thingiverse is a great place to find STL files to print. Another place to find 3D models
is GrabCad. GrabCad has many models for many different CAD programs. There are a couple things to
consider when selecting or designing a 3D model.

ORIENTATION: The orientation of your part is critical to a successful print. Different orientations will
produce a difference in strength, print time, appearance and success rate. Envision the printing orientation
of your prints when designing, feature by feature. This will greatly enhance your printing experience.

SUPPORT MATERIAL: There are three ways to approach support material. The best way is to design and
orient the print so that it does not need any support. The next best option is to design your own supports
into the part. This way there is only support where you want it and it is easy to remove. You can also control
how thick the supports as well. The last way is to have the slicing program “generate support material”
where needed. This is helpful when options one and two do not work sufficiently. This is the most extensive
method of printing. It takes time and patience.

SETTINGS: AWe highly recommend starting with the default settings that come with the printer. We

have spent countless hours perfecting these settings and are a great place to start. These are already pre-
configured settings for each of the materials. Quite regularly we update the material settings, so send us an
email for the latest versions. Another thing to consider while designing is what settings you will ultimately
use to slice the part (fast/slow, solid/hollow, etc). One way that you will select settings is by the application
of your part. For parts under stress or heat, you may want to select slow print settings and make it almost
completely solid. For parts like sculptures or statues where there is almost no physical function of the part,
you may select fast and hollow settings. DOWNLOAD PRINT SETTINGS HERE

MATERIAL SELECTION: Material selection plays a big part in the application of your part. ABS is by far
the easiest and cheapest material to print with. It can take physical and thermal stresses quite well and can
be post processed easily. Turn to the “Materials Selection” section for a more in depth introduction to the
different materials.

2 CONVERT TO STL FILE TYPE: STL is a file type created specifically for 3D printing. All modern 3D
Printers, desktop and industrial, use the STL file format and it is therefore transferable between various 3D
Printing operating programs. It stands for Standard Tessellation Language but is commonly mislabeled as
Stereolithography. STL files are composed of data points in three dimensional space and triangles linking
those data points, therefore creating a mesh. It is important that this mesh is clean and watertight so the
slicing software can properly interpret the data, the next section covers how to ensure a clean watertight
mesh.

When exporting an STL from your CAD program it is important to make sure your settings are not
unnecessarily high resolution. Creating very high resolution STLs can often times cause processing delays
and issues when slicing or printing. It is good practice to generate STL files with parameters tailored to the
capabilities of your machine.

Recommended settings for the HD are as follows:

ce: 0.05mm or greater



https://www.dropbox.com/sh/48itfsw2taexafj/AACaRn-pMQF9HlBcOZZ-BcZZa?n=200240788

GUIDE TO 3D PRINTING

3 NETFABB: LAYOUT (STL CLEAN UP): Having a clean STL file is crucial to a successful slice

and eventually a successful print. Depending on the CAD program used to design the 3D model, and also
the complexity of the 3D model, some create the STL file cleaner than others. But just to be safe, it is a
good rule of thumb to clean up your STL file. This is a great place to check to make sure the partis in the
printing orientation. You can also check to make sure your CAD program exported it correctly size wise.
This software can be used to make sure your STL file is “watertight” for printing correctly as well. This is
especially important when designing in CAD programs like SketchUp. If you do change the units in Netfabb
from millimeters to inches, make sure to switch it back to millimeters before exporting the STL file.

E.dit".a Extras View Settings Help
* A B 000000 HVOBO L -2 yRLDP-AR- +@ o

o - ® parts -
2 | = Slices |
=5
o
g
Cuts

DOWNLOAD NETFABB: S p—

www.netfabb.com y — =
: I mm
z 4 [ 000 mm
<cutting disabled= - l

PAR Execute cut Reset

Information
Length: 0.00 mm § Volume: 0.00 cme
Width: 0.00 mm | Area: 0.00 cm®
Height: 0.00 mm J Triangles: 0

0 of 0 parts are selected.

NETFABB CLOUD SERVICE:
https:/netfabb.azurewebsites.net/

If you have a Microsoft account, you can also use Netfabb's cloud service to repair your models. Simply
upload the STL file and Netfabb will automatically repair it. Download the repaired file and you are ready
for slicing.



http://www.netfabb.com/
https://netfabb.azurewebsites.net/

GUIDE TO 3D PRINTING

3 NETFABB BASIC STEPS TO REPAIRING A FILE:
1. Download Netfabb Basic: www.netfabb.com
2. Open Netfabb Basic ~#

3. “Project” > “Open” > PART.STL: Open your STL file. Check to make sure
your part is the correct size.

4. "Part” > “Rotate Part": Rotate your part into the orientation that you want to
print. J

2
5. “Extras” > “Repair Part”: This will begin the short repair process. +

6. Automatic Repair: Click "Automatic Repair” in the lower right corner of the
window. [

Automatic repair ]

7. Default Repair: A new window will appear. Select “"Default Repair.’

Simple repair
8. Execute: Click “Execute” and return to the main window.

Execute ]

9. Apply Repair: This will finalize the repair of your STL. Select "Yes" to
remove the old part. [ Apply repair |

10. Export the Repaired File: "Part” > "Export Part” > “As STL." Make sure the
file type is STL.

l" SLICING: Slicing is what 3D printing is all about. Slicing is a process in where the STL file is “sliced” into
thin layers for the printer. There are three parts to this process; the STL file, the settings, and the GCODE.
The slicing engine that is utilized for the HD2x is Cura. It creates GCODE. The time taken to slice an STL file

is dependent on the complexity of the geometry, the settings selected and the computing power of your
computer. Cura can usually slice just about anything. As you start getting more experienced, you can start
adjusting certain settings to increase the quality of your specific parts.

Some General Settings for the HD printer (these are already included in our preset settings):

Retraction Length = 7mm (use value in default settings)

Retraction Speed = 50mm/s (use value in default settings)

HD2x Layer Height = a multiple of 0.02mm — ACME lead screw (0.04, 0.06, 0.08... up to 0.40mm)

LOAD CONFIGURATION @ GCODE
+ OR IMPORT SETTINGS @

The GCODE is instructions
for the printer. The process
of slicing is taking the STL
file, adding the settings and
creating the GCODE.

These settings are dependent
on the printing material and the
application of your part. This
includes temperature, speed,

The STL file is your
designed or downloaded
part.

‘__

on, etc.


http://www.netfabb.com/
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ll- USING THE CURA INTERFACE
FILE MENU: The file menu allows you to import SETTINGS MENUS: There are 3 main

your STL file, save your STL file, import settings, export menus for settings within Cura. These are Basic,
settings, and export GCODE. Advanced and Expert.

Layer height {mm)

Shell thidkness {mm}
Enable retraction [¥]

Fill
BottomTop thicdkness {mm) 1

Fill Density (%) 25
Speed and Temperature
Print speed {mm /=) 30
Printing temperature (C) 240
2nd nozzle temperature (C) 0

Bed temperature {C) 115]
Support _
Cnnnnrt tune | Minme "!"]

BASIC: The "Basic” menu allows the user to set basic settings like Layer height, fill density (infill%), print speed
and temperature. These are the most common, and most important settings for 3D printing.

ADVANCED: The “Advanced” menu contains other settings which are very important to achieve a good
quality print. These settings include retraction, nozzle diameter, first layer speeds and cooling options.

|

EXPERT: The “EXPERT” menu is located in the main menu of Cura. Support material settings, skirt options,
and more in-depth print settings can be applied here. This menu is especially helpful when adding support
| material to a model.

Settings Menus will be explained in more detail in the single and dual print sections.
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L USING THE CURA INTERFACE: TOOLS
LOAD: The “Load" icon allows SAVE TOOLPATH: thisicon VIEW MODE:Thisoption allows

you to load your model without  gives you the option of saving GCODE the user to view a 3D model in different
having to go into the “File” menu. without going into the “File” menu. modes. These include “Normal,”
“Overhang,’” “Transparent,” “X-Ray,” and
“Layers.” “Layers” mode is especially
useful for viewing the GCODE of a model

after print settings have been applied.

Mb

heurshlBiminttes
521 ineterd60)

5
7

R

ROTATE: the "Rotate” iconis SCALE: when clicking the “Scale” MIRROR: The “Mirror” option

used to rotate a 3D model within icon, a dialogue box appears withan X,  allows a user to mirror the 3D model
Cura. This can be used to achieve Y, and Z ratio. The ratio is set at 1, and on either the X, Y, or Z axis.

different orientations. After by changing it you can change the scale
clicking the icon, 3 colored circles  ratio of the model. You can choose to
will appear around the model, scale the model uniformly, or on one
each representing a different single axis.

axis. By clicking on and dragging

one of the axis markers (colored OTHER FUNCTIONS: By right clicking on your model you can
circles) you can now rotate the have more functionality such as duplicating your model, splitting your model
model by moving your mouse. into multiple parts, deleting the model, or centering your model on the build

A degree marker will appear platform. —
allowing the user to see how

many degrees the model is being

rotated. You can also hit the “Lay

Flat button to lay the model flat

on the bed.
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L4 SINGLE HEAD PRINTING

STEP 1: OPEN CURA
Open Cura to slice your STL file and select “Machine > HD2x."

STEP 2: LOAD MODEL FILE
“File > Load Model File(s)” to load the STL file on to the bed platform.

g & Cura- 1407

' Tools Machine Expert Help

A TE S — - _

Lead model file... CTRL+L l
|

STEP 3: OPEN PROFILE

“File > Open Profile” to import print settings. Make sure to choose the correct settings for
the material being used and type of print. Once the settings have been imported, Cura will
Slice your STL file(s) in real time. You can find all print settings below or on the USB drive
included with the printer.

prin.. CIRL+# DOWNLOAD PRINT
Save GCode.. SETTINGS HERE

Show slice engine log...

Open Profile...

STEP 4: SAVE GCODE
“File > Save GCODE" to export the GCODE. It is very helpful to name the GCODE file:
"MATERIAL_PART NAME." This will ensure that the GCODE file is printed with the correct

material.
File | Tocls Machine Expert Help
Lead model file... CTRL+L
Save model... CTRL+5
Reload platform F5

Clear platform

Print... CTEL+P
Save GCode...

e |

Show slice engine log...


https://www.dropbox.com/sh/48itfsw2taexafj/AACaRn-pMQF9HlBcOZZ-BcZZa?n=200240788
https://www.dropbox.com/sh/48itfsw2taexafj/AACaRn-pMQF9HlBcOZZ-BcZZa?n=200240788
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L4Q SINGLE HEAD PRINTING
BASIC SETTINGS MENU

After opening Cura, the Basic Menu will open as
default. This menu will change slightly for dual
head operation.

Basic | Advanced I Plugins | SmrﬂEnd-GCndel
Quality
Layer height {mm) 0.2
Shell thickness {mm) 3
Enable retraction
Fill
Bottom/Top thickness (mm) 1
Fill Density (%) 25

speed and Temperature

Print speed (mm/s) 30

Printing temperature (C) 240

Bed temperature (C) 115

Support

Support type [Nnne 'r]
Platform adhesion type [Nune v]
Filament

Diarneter (mm) 2.85

Flow (%) 100.0

Printing temperature is the first setting to take
into consideration when changing to a different
material. Different materials usually require
different temperatures. This setting is also useful
for changing print quality on large and small prints.
For smaller prints, reducing the nozzle temperature

by 5-10C can greatly increase the print quality.
For larger prints, higher nozzle temperatures are

recommended.

Support type is only used if the model has
| overhangs or contoured shapes which do not have
a base for the model to “stand” on when being
printed. “Touching build plate” only generates
support material from the part to the heat bed.
“Everywhere” will generate support within the
model. More detailed support settings will be
described in the Expert Settings Menu.

Layer Height determines the resolution on the
Z-axis and will greatly effect the quality of a print.
Use multiples of 0.020 since we are using a 2mm
pitch lead screw on the Z-axis. With the HD series
of printers, you can print from 0.060 - 0.40. Other
settings will effect the outcome of printing at
different layer heights.

Shell Thickness determines the strength and
thickness of a wall of a 3D print. This is also called
the perimeter setting. Changing this value will

NOT change the geometry of a print. The minimum
shell thickness is determined by the size of nozzle
being used. 0.50 mm shell thickness is equal to 1
perimeter.

Fill density determines the amount of infill a

3D printed part will have. This effects the print
time, strength, and density of a 3D print. Itis
recommended to use the least amount of infill
possible while still retaining the strength needed for
the specific part. For sculptures, you can usually get
by with 0-10%, and for mechanical parts, 30-60% is
recommended.

Print speed is measured by how many millimeters
of material is printed per second. This setting is
not only used to control how long a print takes, but
also to achieve certain results on different sized
objects. For large prints, faster print speeds can be
used. Print speeds generally range from 10mm/s
(millimeters per second) to 75mm/s. Faster speeds
can be achieved, but will effect the quality of the
print.

Bed temperature: For small prints, it is
recommended to use lower bed temperatures to
prevent warping. Too much heat in a small area
can cause a print to fail. If a small part is “soft” and
is not taking shape (turning into a ball of goo), it

is recommended to lower the bed temperature.
Generally the hotter the bed temperature, the
better the part will stick to the glass. The bed
temperature will vary depending on the material
being used.

Filament Diameter will effect the flow of the
material being extruded. It is recommended to use
the default Diameter in the provided settings.
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L4Q SINGLE HEAD PRINTING
ADVANCED SETTINGS MENU

The "Advanced” menu is located next to the “Basic”
settings tab. This menu features more advanced
settings which further enable the user to control the
outcome of a 3D print.

Basic | Advanced | Plugins | Start/End-GCode |

Machine

Mozzle size {mm) 0.5
Retraction

Speed (mm/s) 50.0
Distance (mm) 7
Quality

Initial layer thickness (mm) 0.3
Initial layer line with (%) 110
Cut off object bottom (mm) 0.0

Dual extrusion overlap (mm) 0.2

Speed

Travel speed {mm/s) 125
Bottom layer speed (mm/s) 15
Infill speed {mmjs) 0.0
Cuter shell speed (mmyfs) 0.0

Inner shell speed (mm/s) 0.0

Cool
Minimal layer time (sec) 20
Enable cooling fan (&l

- Use the Cooling Settings which are provided in the default print settings for Cura. For most prints, the

cooling fan will not be used. In rare cases, small ABS prints will use the cooling fan, but usually this is only
used for printing with PLA. To use the fan, check in the expert settings to set the min and max to 100%

EE—

The Nozzle size setting is used to define the
diameter of nozzle being used. All HD models
come standard with a 0.5mm nozzle, and it is
recommended that a new user becomes familiar
with the 0.5 nozzle settings before changing

to the smaller 0.35 nozzle. If changing to the
0.35 nozzle, makes sure to enter “0.35" in this
settings box. It is also recommended to print
slower with the .035 nozzle.

Retraction determines how much material is
brought back into the head when changing to

a different part of a print. This helps eliminate
dripping of material. The HD series usually uses
7mm of retraction for single-head prints. We
recommend that this setting not be changed.

The Speed section in the “Advanced Settings”
menu gives the user more ways to control the
speeds of a print. This includes “Travel speed”
(how fast the head moves between point A and
point B when not printing), “Bottom layer speed”
(how fast the first layer is printed), “Infill speed”
(how fast infill/Fill density is printed), “Outer shell
speed” (how fast the outer perimeter is printed)
and “Inner shell speed” (how fast the inner
perimeter is printed).

Print speed is measured by millimeters of
movement by the nozzle in the XY plane. This
setting is not only used to control how long a
print takes, but also to achieve certain results on
different sized objects. For large prints, faster
print speeds can be used. Print speeds generally
range from 10mm/s (millimeters per second) to
75mm/s. Faster speeds can be achieved, but will
effect the quality of the print.
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ll-b SINGLE HEAD PRINTING WITH SUPPORT

EXPERT SETTINGS MENU
To open the “Expert Settings” window, go to
"Expert” > "Open Expert Settings.”

Advanced

Plugir
Machine

| Mozzle size (mm)
Retraction

Speed (mm/s)

Distance {mm)

Switch to quickprint...
Switch to full settings...

COpen expert settings...

Run first run wizard...
Run bed leveling wizard...

Run head offset wizard...

CTRL+E

| Quality

gelrdaim
Minimum travel (mm)

Enable combing

Z hop when retracting {mm)
Skirt

Line count

Start distance {mm)

Minimal length {mm)

Cool

Fan full on at height {mm)
Fan speed min {3%&)

Fan speed max (%)
Minimum speed {mm/s)
Cool head lift

Tl

Solid infill top
Solid infill bottom

Infil overlap (%)

1.

Minimal extrusion before retracting {mm) 0.

8

0.5

[
15

SUDpL
Structure type

Overhang angle for support (deg) ©

Z-hop is used to allow the nozzles to clear the
print when traveling (not extruding material).

A Skirt is automatically generated in Cura. If
parts are not sticking to the bed correctly, set the
start distance to “0." You can also set the line
count to provide a larger surface area to bond

to the bed. This is especially useful for printing
polycarbonate and nylon.

Fans are used for PLA, and for some other
materials when printing very small parts. For the
fan to work properly, the fans max/min should be
set to 100%. Anything less will cause the fan to
not work properly.

When using break-away
support material (single
head), it is recommended
to use “Lines” as the

|| “Support Type.” It is not

Lines -

15

F gk () _ recommended to use
Distance X/¥ (mm) <l support “Fill Amount”
Distance Z {mm) 0.15 above 60%.

BadeMoge i

Spiralize the outer contour I_:I

Only follow mesh surface L]

Brim

Brim line amount 20

Raft

Extra margin {mm} 5.0

Line spacing {mm) 1

Base thickness {mm) 0.3

Base line width (mm) 7

Interface thickness {mm) 0.2

Interface line width {mm) 0.2

Airgap 0.22

Surface layers 2

Fix horrible

Combine everything (Type-A) 1l
Combine everything {Type-B) |

Keep open faces
Extensive stitching

ok |
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L4C DUAL HEAD PRINTING WITH SUPPORT

STEP 1: OPEN CURA
Open Cura to slice your STL files. Make sure you select the machine that was setup as a
“dual extruder” machine. Go to “Machine > Machine Settings” to select.

STEP 2: LOAD MODEL FILE
“File > Load Model File” to load the STL file on to the bed platform.

[[Fie] Took: Meachine Expert Help

Load model file... CTRL+L | |
STEP 3: OPEN PROFILE
“File > Open Profile” to import print settings. Make sure to choose the correct settings for
the material(s) being used and type of print. Once the settings have been imported, Cura will
slice your STL file in real time. Make sure to import the settings for SUPPORT to be printed.

You can find all print settings below or on the USB drive included with the printer.
Save GCode...

Show slice engine log...

Open Profile...

STEP 4: SUPPORT MATERIAL

There are 2 kinds of support (Touching Buildplate, Everywhere). “Touching Buildplate” will
generate support material that connects the bed and the part. “Everywhere” will generate
support within the part, as well as from the part to the bed.

Support

5"““; = DOWNLOAD PRINT
o - . SETTINGS HERE

Platform adhesion type Touching buildplate ‘

Support dual extrusion ~ Everywhere Support type [N - . ]

STEP 5: SELECTING BUILD AND SUPPORT Platform achesion tyoe o -]

MATERIAL EXTRUDER , _ -

Selecting the correct hotend to do the build and the ~ SvPPertdual extrusion th

support material is done by which extruder is chosen  pual extrusion First exiruder

' wn menu “Support dual extrusion.” Other winesnrime tower Second extruder

be found in the expert settings section

STEP 6: SAVE GCODE

- "File > Save GCODE" to export the GCODE. It is very —
helpful to name the GCODE file: “MATERIAL_PART NAME." This will ensure that the GCODE
~ fileis printed with the correct material. Save GCode...



https://www.dropbox.com/sh/48itfsw2taexafj/AACaRn-pMQF9HlBcOZZ-BcZZa?n=200240788
https://www.dropbox.com/sh/48itfsw2taexafj/AACaRn-pMQF9HlBcOZZ-BcZZa?n=200240788
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ll-d DUAL HEAD PRINTING WITH 2 COLORS / MATERIALS

This is usually used for dual color (same material) printing. But it can also be used if you
were to design in your own support and make it a separate STL file.

STEP 1: OPEN CURA

Open Cura to slice your STL file and select “Machine > HD2x." DOWNLOAD PRINT
c SETTINGS HERE

STEP 2: LOAD MODEL FILE
“File > Load Model File(s)” to load the 2 STL files on to the bed platform. The 2 STL files
must be exported from the same CAD file for them to align properly. The first STL file

| a- 1407 you bring in will be printed with the first
: HEE T ———— nozzle, the 2nd STL file will be printed with

Load model file... CTRL+L ! the 2nd nozzle.
I

STEP 3: DUAL EXTRUDSION MERGE

Right click one of the models and select “Dual Extrusion Merge." If the previous steps were
done correctly, it should merge the STL files back to the way they were in the CAD software
and show the 2 STL files in different colors. k I e ]
STEP 4: OPEN PROFILE T

“File > Open Profile” to import print settings. Make sure to choose the correct settings for
the material(s) being used and type of print. Once the settings have been imported, Cura
will slice your STL file(s) in real time. You can find all print settings below or on the USB drive
included with the printer. Show slice engine log...

Center on platform
Delete ohject
Multiply object

Split object into parts

Dual extrusicn merge

Open Profile...

STEP 5: SELECTING STL FILES
After merging STL files, one STL will remain yellow in color, and the other will turn red. The
yellow STL will be printed with Extruder 1 (if facing the printer, it will be the left extruder),

and the red STL will be printed W|th Extruder 2 (if facing the printer, it will be the right

STEP 6: SAVE GCODE

"File > Save GCODE" to export the GCODE. It is very helpful to name the GCODE file:
“MATERIAL_PART NAME." This will ensure that the GCODE file is printed with the correct
material. |

Save GCode...



https://www.dropbox.com/sh/48itfsw2taexafj/AACaRn-pMQF9HlBcOZZ-BcZZa?n=200240788
https://www.dropbox.com/sh/48itfsw2taexafj/AACaRn-pMQF9HlBcOZZ-BcZZa?n=200240788
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ll-d DUAL HEAD PRINTING WITH 2 COLORS / MATERIALS

BASIC SETTINGS MENU

After opening Cura, the Basic Menu will open
as default. This menu will change slightly for

single head operation.

2nd Nozzle Temp: When printing with the dual hot
end, only one temperature is needed because of

the configuration of the printer. The hot end has 2
nozzles, but only one heating element.

This means that the “2nd nozzle temperature” should

Fill be set to ‘0’ When this happens the 2nd nozzle is
Bottom/Top thickness (mm) 1 assumed to be the same temperature as the 1st
Fill Density (%) 25 nozzle.

Speed and Temperature
Print speed {mm)/s) 30
Printing temperature (C) 240
2nd nozzle temperature (C) 0

Support Dual Extrusion: This setting is used to select
which nozzle will be used to extrude the support
material. Generally extruder 1 is used for build
material and Extruder 2 is used for support material. It
may be useful to use a raft when printing with support
material. This will help the build and support material

Bed temperature (C) 115 stick to the glass.
Support A Wipe & prime tower can be used to help prime the
Support type [Nnne v] nozzle between switching colors/materials.
Platform adhesion type  [None -] An Ooze shield can be used to catch any drips of
Support dual extrusion [Semnd extruder "] material coming out of the inactive nozzle when
printing.
Dual extrusion
Wipe&prime tower [ The Diameter 2 setting is used to achieve
Ooze shield [ different flow rates from the second extruder. It is
Filament recommended to keep this at 0. When at O, Diameter
2 will be set to the same value as Diameter 1.
Diameter (mm) 2.85
Diiameter2 (mm}) i
Flow (%) 100.0 Advanced | plugins | Start/End-GCode |
Machine
MNozzle size (mm) 0.5
ADVANCED SETTIN_GS MENU Retraction
The "Advanced” menu is located next to the =
“Basic” settings tab. This menu features more Speed (mm/s)
advanced settings which further enable the user Distance (mm) 3
- to control the outcome of a 3D print. Dual extrusion switch amount (mm) 20
= Retraction: It is highly recommended to leave Quality
the retraction settings as default after importing gl
:‘ default SEttlngS' Inner shell speed (mm/s) 0.0
Cool: Fans are not generally used for single Cool
~ head prints (unless using PLA), but for dual head Minimal layer time (sec) 30]
printing the fan helps prevent the dripping of Enable cooling fan

material on to the part.




GUIDE TO 3D PRINTING

ll-d DUAL HEAD PRINTING WITH 2 COLORS / MATERIALS

EXPERT SETTINGS MENU Z-hop is used to allow the nozzles to clear the print when
To open the “Expert Settings” window, go to  traveling (not extruding material).

"Expert” > "Open Expert Settings.” _ _
Fan Speed: For most dual head prints, the fan max/min

Eoe u I -hould be set to %100. This will prevent dripping which is

File Tools Machine [Expert] Help common when printing with dual extruders.
| Basic | Advanced | Plugiy Switch to quickprint...

Machine | © | Switch to full settings...

Support: When using a dissolvable support material, it is
Nozzle size (mm) | Open expert seftings... CTRL+E recommended to use “Grid” as the “Structure type.” For
break-away support, “Lines” can be used, as it makes

Retraction | Run first run wizard... X . .

| specd gomss) | (b evtiog e removing support much easier. It is not recommended to
Distance {mm) Run head offset wizard... use Support ”FIH amount” above 60%'

| Quaity |

o -] - B
Retraction Sanport

Minirmum travel (mm) 2 Structure type Lines -
Enable combing ] Overhang angle for support {deg) 0 |
Minimal extrusion before retracting {mm) 0.1 Fill amount (%) 15' |
Z hop when retracting {mm) 0.5 Distance XY (mm) III.?.
Skirt _ Distance Z {mm) 0.15
Line count 3 Black Magic
Start distance (mm) 3 é.ﬁi:rali.ze.ﬁﬁe Sl ettt ; I_:I
Mirimal length {mm) 150.0 Only follow mesh surface ]
Cool ol :
Fan full on at height {mm) 0.5 B e St 4
Fan speed min (%) ] Raft
Fan speed max (3&) 0 Extra margin {mm) 5.0
Minirmum speed {mm/s) 5 Line spacing (mm) 1
Cool head lift [} Base thickness {mm) 0.3
Infill Base line width {mm) 7
Solid infill top E_' Interface thickness {mm) 0.2
Solid infill bottam [#]
Infill overlap (%) 1'5 Interface line width (mm) 0.2
- Airgap 0.22
— Surface layers 2
Fix horrible
| Combine everything (Type-8) ||
Combine everything {Type-B) |
Keep open faces |
. Extensive stitching [

ok |
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5 USING THE REPETIER HOST INTERFACE
MAIN FUNCTION BUTTONS VIEWING TABS

=

—— CONNECT/DISCONNECT: Used to
connect/disconnect the printer to
the computer

LOAD: Used to load the GCODE file
[KILL PRINT: Used to stop the print

START PRINT: Used to start the print=

=3D VIEW: Used to view and analyze the
GCODEin 3D

TEMPERATURE CURVE: Used to view and
analyze the nozzle and bed temperature
over time

Object Placeme nt | Slic

20

PRINTER SETTINGS
AND EMERGENCY STOP

PRINTER SETTINGS: Used to
setup/configure/connect to
the printer for use

EASY MODE: Used to narrow
the functionality of the 3
printer for a simpler experience

EMERGENCY STOP: Used to

Idle |

MAIN FUNCTION TABS

PREVIEW: Used to setup/
configure/connect to the
printer for use

MANUAL CONTROL: Used to narrow
the functionality of the 3D printer for
a more simple experience

instantly stop (kill) the printer
movement and temperature
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5 USING THE REPETIER HOST INTERFACE
PREVIEWING GCODE

GCODE PREVIEW TAB

GCODE EDITOR: Used to view the GCODE
in text form

— ESTIMATED PRINT STATS: Displays the

3D GCODE VIEWER CONTROLS: Used
to control the 3D view of the GCODE.
Purely used for viewing. This will not

estimated print time for the GCODE

affect the print.

file view [fonfig  Printer  Tooks  Help

O . Bl
Connect  Lood

A i

Sove Print Start Prnt Kol Pt Toggle Log. Show Fifament  Hade Travel

3D View | Teperture Curve|

e

C|

rinter Settings Easy Mode  Emergency Stop
| Meruial Contre [ 5D Cat |

Printng statietics
.i.’ Estimated Printing Time: 12h:23m17s
_ Layer Count: 245
pe Total Lines: 1038395
Fil nt 16810 mm

[T Snaw Trawed Maves
@ Show complete Code
Frst Layer
La#: Layer.

(1]
£l

| Show Single Layer

| Show Layer Range

Disconnected: HD2x

Idie
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5 USING THE REPETIER HOST INTERFACE

X, Y, Z Home position. Based on the The status bar will show what Used to switch between
min. limit switches. the printer is doing (preheating, Extruder 1 and Extruder 2.
printing, ETA, etc.)

Y-axis home position

Motion Conrols for Z axis

Purge / Extrude
Material. Manually
extruding 500mm-
1000mm or material
will purge the hot end
of most, if not all of the
previous material. This
is very useful when
switching materials.

X-axis home position

Motion Conrols for X and
Y axis =

Home position for X, Y
and Z axis

Z-axis home position

The Flowrate will allow
the user to change

" how much material is
extruded during a print.
This will not affect the

Feedrateisaspeed — ==
multiplier. This can be
used to speed up or slow
down a print by a certain

percentage while printing. — 'R " T B :
(Useful range = 75-125%), — — speed of the print.

if set any higher or lower, [ ——— 20 =1 | The fan control can be
you may experience 17 s == 1 e 240 2| | used to turn the fan
difficulties with the Debiie Oiiorss on or off during a print.

retraction speed, etc. If
you need to go faster or

@ o |O] o |© Eo=  |@ Dymw | [ox || (OFF=0-99, ON=100)

slower, it is recommended  Used to control the Used to control the
to change the speeds in temperature of Extruder temperature of the heat bed.
the slice settings. 1. Extruder 2 will match Recommended range (0-140C).

the same temperature as
Extruder 1, as they share
the same heat source.

Recommended range (0-
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5 PRINTING WITH REPETIER HOST INTERFACE

STEP 1: OPEN REPETIER HOST —
Open Repetier Host to view the GCODE. m

STEP 2: LOAD GCODE FILE @
“Load” > (GCODE FILE.GCODE) to import the GCODE file. = -

Load

STEP 3: ANALYZING THE GCODE FILE

Under the “"Preview” tab you will be able to see a 3D view of the GCODE file. As experience
is gained, this step will greatly improve the quality of prints and also give the user a better
understanding of the slicing process. It is a good idea that when starting out, the user looks
at the GCODE first to get a better understanding of how the settings were applied. In this
tab, the user can scroll through the GCODE file layer by layer to do a deeper analysis of the
sliced part. It will also give you the estimated printing time.

STEP 4: PREPARE BUILD PLATFORM
Refer to Materials section on how to prepare the bed for different materials.
(see quickstart guide)

STEP 5: LOAD FILAMENT/PURGE
Load the correct filament into the hotend(s).

STEP 6: PREHEAT THE HOT END AND BED
Under the "“Manual Control” tab, click the extruder icon to preheat the hot end. Do the same

with the bed icon to preheat the heat bed. _ - X
A e = = 5C 25 10 MIEE

I/ o = 3 [ 20 |
- 17 e — e 20 [
= STEP 7: START PRINT
Use the “Start Print” button to run the GCODE. MAKE SURE TO WATCH THE FIRST COUPLE

— LAYERS AND EVERY 30 MINUTES PERIODICALLY AFTER.

Start Print




UNBOXING

Remove the printer from the box.
Remove the labled zip ties from the bed
and the twisty ties from belts. Open the
accessory kit. Plug the power cord into
the back of the printer and into a power
source (surge protector is highly
recommended). Turn power switch to the
ON position. Raise bed up using VIKI
controller (see VIKI section in manual) or
by hand by turning the Z-axis rod.

Watch the unboxing

"E.,x video here Click here for link.

FINISH ASSEMBLY

Insert the PTFE tube into the
push-to-connect fitting on top of the hot
end (x2). Clamp extruder and release the
pin (x2). Insert the plastic white adapter
into the extruder assembly (x2).
IMPORTANT!
Make sure to
push the tube all

the way down
until it stops
Push Down Tube

Lift Up Hot End 1

TESTING AND CALIBRATING
Preheat the nozzle/bed from VIKI

Heat bed: Remove the borosilcate glass
from the manilla envelope DO NOT
REMOVE THE PET FILM FROM THE GLASS!

Coat the glass to the edge with a purple
Elmer’s glue stick. Lay the glass on the red
heat bed, PET film facing upward.

Place the binder clips in the 4 corners of the
bed (make sure t he front left clip is in about
2-3" from the corner).

Extruder/Filament: Place the spools of
filament on the spool minder (x2). Wait until
the nozzle reaches 240C. Feed the filament
through the back panel and up into the
bottom of the extruder assembly. Manually
feed the filament into the hot end until you
see it come out the nozzle (it will be a tight
fit, but this will break-in over time). Close
the extruder latch and insert the pin (x2).
Extrude material from Extruder 1 (Extruder
2 must be operated by software, Repetier
Host). The material should be flowing
correctly: smooth and vertically downward.

Run the calibration Print (scan the QR code

to watch the video), or click here for link.

1. Speed test

. Y-Speed test

. Center adjustment - Z-Adjust

. Corner adjustments - corner
screws (twice around)

. Z-axis test

. Dual rectangle print
What is a good/bad first layer
and how to make the .
adjustment.

Re-run the Dual Rectangle if

need be to make additional

adjustments

N oo

D QO



https://www.youtube.com/watch?v=q91oaK0Kg7g
https://www.youtube.com/watch?v=Jw6S9JLaPUg

MATERIALS

3D PRINTING MATERIALS
This chart separates printing materials into temperature ranges and properties. When making

new settings, or adjusting the default material settings, make sure to follow this chart.

MATERIALS <

GENERAL
DESCRIPTION & <
CHEMICAL TERMS

MECHANICAL _/
PROPERTIES N




MAINTENANCE

REQUIRED TOOLS: Razor blade(s), a roll of PLA for purging for soft materials,
white lithium grease.

THESE MAINTENANCE STEPS SHOULD BE CARRIED OUT EVERY 100
PRINTING HOURS

1. PURGING NOZZLE: Ensure the nozzle is at high temperature (260C for ABS,
PLA, etc. / 290C for Nylon / 315C for polycarbonate). For a material change,
you want to purge at least 1000 mm. Return the nozzle to temperature of
intended print material once purging is complete. The new material should

be flowing smoothly and vertically out of the nozzle. If not, keep extruding
material if it still persists. Purging with PLA may be beneficial because it

has such a low melting temperature (used especially when purging for soft
material use).

2. CLEANING/SWITCHING NOZZLE: Heat the nozzle to the printing temp of
the current material being used. Remove the material from the hot end and
check for a mouse bite (an area in the filament that has been eaten away by
the hobbed bolt). Be careful, the nozzle will be extremely hot (USE GLOVES).
Use pliers to hold heating element and remove the 2 button head screws with
a straight end allen wrench/hex drive. Remove the nozzle and set aside (IT IS
STILL HOT!). Use a razor blade to scrape the debris off of the bottom of the
heating element. Now let the nozzle cool. Depending on how much filament
is in the nozzle, you may have to soak it in acetone from 2-12 hours. DO NOT
STICK ANYTHING THROUGH THE NOZZLE HOLE AS THIS CAN DAMAGE THE
NOZZLE PERMANENTLY. Replace the nozzle once it is cool, remember to

use the spring washers and tighten the 2 screws down snug (DO NOT OVER
TIGHTEN) remember to use the pliers to hold the heating element as well.

3. LUBRICATION: Use white lithium grease (can be found at most hardware
stores to coat all smooth and threaded rods. You can be fairly liberal with the
grease, but be careful not to get any on the acrylic frame panels.




MAINTENANCE

WIRING DIAGRAM

Motor: X, Y, Z1, EO, and E1

Limit Switches: All 6 limit switches are used

Heaters: Heat O is for the extruder (heating element), Heat2Bed is for the heat bed
Thermistors: TO is for reading the extruder temperature, T1 is spliced with TO to read the
extruder

temperature, T2 is for reading the heat bed temperature

Fans: Fan O is for the extruder fan, Fan 1 is for the LED lights

Fuses: Motor Fuse, Heating Element Fuse (Nozzle), and Heat Bed Fuse

RAMBo has 3 replaceable fuses. The small white fuse holders are Little Fuse OMNIBLOCK fuse
holders. They are compatible with NANOZ Fuses. Fast or very fast acting are recommended. An
example part number for replacement fuses is 0448005.MR

VIKI LCD Screen: 12C(14), SPI(36), EXT(13, 15, 17, 19)

VIKI WIRING
Wire Color Cable A Cable B
RED 12C 4 SPI 6
BLACK 12C 3 EXT 13
BLUE 12C 2 SPI 4
GREEN 12C 1 SPI 5
YELLOW EXT 17 EXT 15
WHITE EXT 19 SPI 3

WIRING DIAGRAM see next page




MAINTENANCE

WIRING DIAGRAM

E1-Motor EO0-Motor Z2-Motor Z1-Motor Y-Motor X-Motor

Z-Max Limit Y-Max Limit X-Max Limit
eSS Switch Switch Switch

Z-Min Limit Y-Min Limit X-Min Limit
SPI (1-8) Switch Switch Switch

USB Port

EXT (1-20)

Heating
Element
Fuse

Ll
+
+

L]
+
—

19)90S Jamod

Heat Bed Heat2Bed
Fuse




TROUBLESHOOTING

1: PART IS NOT STICKING TO BED
a. Open Repetier Host to view the GCODE

b. Generally higher temperatures make for better bed adhesion

C. For ABS, Nylon, PC, etc, make sure to use the purple Elmer’s glue stick on the
PET film.

d. Adding brims to the first layer of your printer (at zero distance) [especially for

PC and nylon]
e. The better the printer is calibrated, the better the first layer is, the better
the part sticks

2: CANNOT GET PART OFF THE GLASS
a. Remove glass from printer and let cool
b. You can use the following tools to help remove the part: Rubber mallet, flimsy
spatula, putty knife, razor blade

3: PART IS WARPING
a. Too much heat, reduce nozzle and bed temp
b. Slower speeds
C. Refer to part 1 (Part is not sticking to bed)

4: PART IS CRACKING
a. Printing with ABS for large parts may tend to crack

b. Increase nozzle/bed temp in 5 degree increments, do not exceed 15 degrees
above default

C. Caused by long prints, try decreasing the print time (increase speeds, decrease
infill, increase layer height)

d. Increasing wall thickness to 2-3 may help

e. Use PLA or PET for larger/longer prints

5: MATERIAL IS NOT EXTRUDING (clicking noise, mouse bite, clogged nozzle)
a. Heat nozzle and remove material and check for mouse bite
b. Heat nozzle to 260C (or 315C for advanced materials), insert material and try to
manually feed the material through the nozzle

C. Close extruder assembly and extrude 500-1000mm of material to flush/purge
the nozzle

d. May consider removing and cleaning the nozzle

e. Use the z-adjust to make sure the nozzle is not too close to the bed

6: PRINTING SMALL PARTS
Use small layer heights (0.100-0.200mm)
wer speeds (10-30mm/s)
mps (5-10 degrees below d




TROUBLESHOOTING

7: PRINTING LARGE PARTS
a. Use large layer heights(0.200-0.400mm)
b. Use faster speeds (30-75mm/s)
C. Use less infill (10-30%)

a. Check connectors behind the Viki display
b. Ensure SD card is not above or below the slot

9: FAN IS NOT WORKING
a. Preheat PLA through the VIKI as this will turn on the FAN
b.  Contact tech support if the fan does not turn on after engaging Preheat PLA

C. The fan only turns on for certain materials, refer to material settings for specific
information

10: MOTORS ARE NOT WORKING
a. X axis, test with Xhome
b. Y axis, test with Yhome

C. Extruder, test with manual extruder control in Viki, will only function when
printer is preheated
d. If all the motors do not move after performing auto home, you may need to

replace fuses, refer to maintenance section of manual for wiring diagram

11: Z-AXIS LOCKED/ BED WILL NOT MOVE UP OR DOWN
a. Please contact tech support for direct assistance




